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Important Notice
We have done the utmost to make certain that the data that appears on the tax forms
produced by the Club Tax Printer software is correct as based on the data in your cur-
rent Club Accounting files. Nevertheless, we do not warrant the accuracy or com-
pleteness of the data on the printed tax forms. All responsibility for accuracy and
completeness rests with your investment club and with the person who handles the
tax matters for your club.
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Using the 2007 Club State Tax Printer 
This Tax Printer program works by reading your Club Accounting data, performing 
certain calculations, then generating your tax forms. The program does not alter 
your original club data stored in the Club Accounting software. To properly use this 
program, you must make sure your accounting records are up-to-date. 

We recommend running the year-end wizard and the 2007 Club Federal Tax Printer 
before running your state taxes. 

System Requirements 
Use of this software requires at least: 

• A compatible Windows operating system (Windows 2000/Windows XP) 
• 128 MB of RAM minimum (256 MB recommended). 
• 30 MB of free hard drive space. 
• Adobe Acrobat 6.0 or higher (required to read and display PDF files). The 

program may be downloaded free of charge from http://www.adobe.com. 
• Club Accounting version 3.1 (CA3) or higher. 
• A current Club Accounting Maintenance contract. 

http://www.adobe.com
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Installing the Club Tax Printer 
There are two installation options, CD or Download: 

If you have received a CD: 
• Insert the CD into your computer’s CD-ROM drive. The installation pro-

gram should launch automatically. 
If you are downloading the program from the Internet: 

• Go to http://www.iclub.com/support/downloads.asp.  
• Click on the name of the appropriate tax printer program. 
• The installation program should launch automatically if you select Open.  
• If you choose not to allow automatic installation, or choose to Save the 

downloaded file to your computer, install the program manually by click-
ing on the 2007 Club Tax Printer Setup icon.  

Preparing the Club Data 
Note: Skip this step if you have already run the 2007 Club Federal Tax Printer. 

Before generating your tax forms, make sure that your club accounting data is prop-
erly prepared. We recommend that you wait until you have all the necessary data 
and have performed a reconciliation of all the partnership accounts before complet-
ing your taxes. Necessary data includes your year-end brokerage and bank state-
ments; all buys, sells, dividends, interest, and service charges through December 31, 
2007; and the Form 1099s issued by your financial institutions. It is likely that you 
will not have this information until late January. 

Once you have all the necessary data and the club has conducted their annual audit, 
close out the books for the year: 

Launch Club Accounting 3, and then: 

1) Select Tools > Year-end Tasks. Follow the instructions to close your 
books for the year. 

2) Exit the program. 

Running the Club State Tax Printer 
The Club State Tax Printer is not a separate program. It is part of Club Accounting 
3. Simply select Taxes from the menu to start preparing your tax forms. 

 

http://www.iclub.com/support/downloads.asp
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If you have multiple clubs loaded in your CA software, each time the Tax Printer is 
launched, you will need to select which club you wish to work with from a list of 
club names. If you would like to use the Tax Printer to generate tax forms for sever-
al clubs, you will need to purchase a Tax Printer serial number for each club. See 
http://www.iclub.com for more information on how to purchase additional serial 
numbers.  

Registration 
When starting the tax printer for 
the first time, you will see the 
registration window. You must 
register your program via the 
Internet with your specific Tax 
Printer serial number before it is 
usable.  

Your Tax Printer serial number is 
proof that you purchased a li-
cense to use this program. It is 
included with your Tax Printer 
packaging. 

If you purchased the downloada-
ble version of this program, your 
Tax Printer serial number will be 
provided to you via email. 

Draft and Final Forms 
The Club State Tax Printer is released early each year, often before final forms have 
been released by the states. When you initially install the program, it may display 
preliminary forms with a “DRAFT” watermark. These draft forms may not be 
used to file a tax return with your state. They are provided so that you may get a 
head-start on the preparation of your forms, diagnose any possible technical prob-
lems, and generally ensure that your tax printer and club accounting software are 
working properly. 

The Club State Tax Printer does have an automatic updater built into the program. 
Each time you start the Club Tax Printer, it will check the Internet to see if any up-
dates are available. (You must be connected to the Internet in order for the auto-
updater to work.) When an update is available, the program will download and au-
tomatically install the new version. 

To check the expected release schedule for your state’s returns, please check 
http://www.iclub.com regularly throughout the tax season. 

http://www.iclub.com
http://www.iclub.com
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Entering Your Club Information 
Once you have registered, you will see a screen listing the states which are included 
in the 2007 Club State Tax Printer. Choose your state and click OK. On the follow-
ing screens, you will be prompted to enter information about your club needed to 
generate your club’s tax forms. 

The specific questions and input required vary by state. Please refer to the help files 
within the program for information that is relevant to your specific state’s tax return. 

Generating Your Tax Forms 
You are now ready to print your State Tax Return. 

You should generate a complete return, and then, if your state requires a schedule 
similar to the Federal Schedule K-1, extra copies of this schedule for each member.  

Check the appropriate boxes to print the: 

• Main tax return. 
• Additional schedules (as appropriate for your state). 

Creating PDF files: Selecting Finish will launch Adobe Acrobat and generate the 
forms in PDF format. From Adobe Acrobat, you can save or print your tax forms. 

Printing your tax forms: To print tax forms, click on the printer icon or go to the 
File > Print menu item after you’ve created a PDF file copy of your club’s tax re-
turn. 

Saving your tax forms: To save your tax forms in PDF format, click on the disk 
icon or go to the File > Save menu item. The files will be saved in Adobe’s PDF 
format. You may read these at anytime using the Adobe Acrobat Reader. 

Additional notes: A “Partner’s identifying number” for each member may be re-
quired for the club’s tax return to be complete. If the message No Tax ID Entered 
shows up next to a member’s name on the final step, or that box is empty, that 
member’s Social Security Number was not entered in Club Accounting. Fill it out 
by hand after you have printed the appropriate tax form. 

Select Quit to exit the Tax Printer. 

What You Need to Send to Your State Tax Agency 
2007 Club State Tax Printer software prints returns and schedules required for filing 
your club’s tax return in a format acceptable to your state’s Tax Department. In-
structions for what to send and where to send your return can be found on the cover 
sheet printed with the return. 
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What You Need to Give to Your Members 
If your state requires it, give each club member a copy of his/her state equivalent to 
the federal Schedule K-1. This schedule will be used in filing their personal state tax 
returns. 

Individuals who withdrew from the club during the year must also be provided with 
the appropriate forms. 

What You Need to Keep for Club Records 
The club should keep a copy of the full state tax return, all attached schedules and 
any additional supporting statements and attachments as part of its permanent 
records. 

We recommend keeping the electronic PDF files in addition to paper copies. 

Common Problems and Release Notes 
• 2007 Club State Tax Printer requires registration before the program can 

be run. Registration can be done over the Internet from within the registra-
tion screen. 

• If you find the program taking a long time to load your Adobe Acrobat 
Reader and Tax Forms, your computer may lack sufficient memory or free 
hard drive space. Select fewer forms to print faster, then repeat this process 
for the remaining forms. 

• Links to all pertinent state forms and instructions can be found within the 
help section of the program. 

• The 2007 Club State Tax Printer software uses industry standard Adobe 
Acrobat software to generate your tax forms. A free copy of Adobe Acro-
bat Reader installs with the tax program, and can also be downloaded from 
http://www.adobe.com. 

Help from ICLUBcentral 
Technical Support is available on our web site at http://www.iclub.com/support. 
You may ask specific questions via our web form and review the Frequently Asked 
Questions section of the web site as well. 

The “Clubhouse” forum on StockCentral.com (http://www.stockcentral.com) is a 
community message board where many club treasurers meet to discuss topics re-
lated to investment club accounting, club taxes, club operations, and more. ICLUB-
central’s club experts may also be found on this forum. To visit, click the Commu-
nity tab at http://www.stockcentral.com, and then select the Clubhouse. 

http://www.adobe.com
http://www.iclub.com/support
http://www.stockcentral.com
http://www.stockcentral.com
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Requesting Technical Support: 
 
To our Treasurers, 
 
Each year, your club’s members look to you to 
make sure their taxes are filed in time. And each 
year, from December to March, ICLUBcentral’s call 
volumes triple. We bring in extra help, update the 
FAQs, and give it our all to answer your questions. 
Your patience during this time is appreciated.  
 
Here’s looking forward to a successful tax season! 
 
Daniel R. Abraham 
VP of Customer Care, 
 ICLUBcentral Inc. 
 

If you cannot solve your problem using online help, the most efficient way to con-
tact an ICLUBcentral Technical Support Representative is to use our web help 
forms located at http://www.iclub.com/support/. Our experts will then easily be able 
to retrieve and reply to your question or problem quickly and efficiently. 

Answers to questions about installation of the Club State Tax Printer are included 
with your purchase of the software. Questions about club accounting principles, tax 
issues, and the Club Accounting software are covered by your Maintenance Agree-
ment. To receive full coverage, you must purchase Accounting Software Mainten-
ance and renew it annually. 

Use the following guide to help our experts quickly answer your questions. Write 
down the precise wording of any error message displayed when you have a prob-
lem, including the names of any files mentioned in the message. Be familiar with: 

• The version of Windows you are using. 
• The make, model and amount of memory (RAM) on your computer. 
• The make and model printer if you have a question regarding printing. 
• Note your Club State Tax Printer serial number and purchase/installation 

date. 

http://www.iclub.com/support/
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About ICLUBcentral Inc. 
ICLUBcentral Inc., located in Cambridge, MA, is the global leader in the develop-
ment of software tools for investment clubs. We have been making club accounting 
and club tax software since 1989, and our products are used by more investment 
clubs than any other in the world. 

Besides Club Accounting 3 and Club Accounting Online at myiclub.com, IC-
LUBcentral also produces software programs for stock analysis, including Inves-
tor’s Toolkit, Stock Analyst, Classic Plus, Stock Prospector, and Take Stock; 
web sites such as StockCentral.com (http://www.stockcentral.com); and newslet-
ters such as the market-beating Investor Advisory Service 
(http://www.iclub.com/ias/). 

For details and special offers for you and your investment club, please visit 
http://www.iclub.com. 

 

http://www.stockcentral.com
http://www.iclub.com/ias/
http://www.iclub.com
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User License and Support Agreement (ULSA)  
Applicable to the 2007 Club Tax Printer. Use of this product is governed by terms of a User License and 
support Agreement or ULSA. THIS LICENSE AND SUPPORT AGREEMENT (THE “AGREE-
MENT”) IS A LEGAL CONTRACT BETWEEN YOUR INVESTMENT CLUB OR YOU IN YOUR 
INDIVIDUAL CAPACITY, AS THE CASE MAY BE AS INDICATED IN THE PRECEDING PA-
RAGRAPH (COLLECTIVELY, “YOU”) AND ICLUBCENTRAL INC. (“ICLUBCENTRAL”). BY 
CLICKING ON “ACCEPT” WHEN YOU INSTALL THE SOFTWARE, YOU ARE AGREEING TO 
BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT, INCLUDING WITH-
OUT LIMITATION THE CUSTOMER SUPPORT PROVISIONS SET OUT BELOW. IF YOU DO 
NOT AGREE TO SUCH TERMS AND CONDITIONS, YOU MUST PROMPTLY RETURN THE 
SOFTWARE ICLUBCENTRAL OR ITS SOFTWARE DISTRIBUTOR, IN ORDER TO RECEIVE A 
FULL REFUND OF THE LICENSE AND CUSTOMER SUPPORT FEES THAT YOU HAVE PAID. If 
You should have any difficulty in obtaining such refund, please contact ICLUBcentral at 1430 Massa-
chusetts Ave, 3rd Floor, Cambridge, MA 02138. 

THE ENCLOSED COPY OF THE 2007 CLUB TAX PRINTER, INCLUSIVE OF ALL ADD-ONS 
AND FUTURE RELEASES, (the “SOFTWARE”), AND THE RELATED DOCUMENTATION, IN-
CLUSIVE OF ALL FUTURE RELEASES (the “DOCUMENTATION”), ARE EACH LICENSED TO 
YOU WITH A NON-EXCLUSIVE AND NON-TRANSFERABLE RIGHT, EXCEPT AS ALLOWED 
BELOW UNDER ‘PERMITTED USES’, TO USE ONLY UNDER THE FOLLOWING TERMS AND 
CONDITIONS: 

PERMITTED USES: You MAY: Install the Software on a storage device in Your computer, as set forth 
in the instructions contained in the Documentation. Note: The Software has been designed to only allow 
it to be used for a single individual in Your investment club on a single personal computer. 

NON-PERMITTED USES: You MAY NOT: 

• Make any copies of the Software. 
• Make any copies of the Documentation. 
• Disclose, rent, license, sublicense, lease, sell, lend, disseminate or otherwise distribute the 

Software or the Documentation.  
• Network the Software or otherwise use it on more than one computer or computer terminal at 

the same time. 
• Use the Software to conduct a service bureau, application service provider (“ASP”) business 

or similar business for the benefit of third parties. 
• Transfer Your rights under this Agreement. 
• Alter, enhance, supplement, create derivative work therefrom, translate, decompile, disassem-

ble, reverse engineer or otherwise reduce the Software to human readable form. 
• Remove or obscure the copyright and trademark notice on the label of the storage medium 

containing the Software or in the Documentation. 
TERMINATION/DURATION: This Agreement and Your license to use the Software and the Docu-
mentation will automatically terminate without notice from ICLUBcentral and without any pro rata ab-
atement of the license and customer support fees You have paid if You fail to comply with any term or 
condition of this Agreement or upon your giving written notice of termination to ICLUBcentral. 

This Agreement is effective from the day upon which You indicate acceptance of this Agreement. In 
order to be granted license to use this Software, you must register this Software fully and accurately with 
ICLUBcentral and receive a valid confirmation of registration from ICLUBcentral. The license then 
granted will continue until either You terminate this Agreement by giving written notice of termination to 
ICLUBcentral; or this Agreement is terminated by ICLUBcentral, as provided in the immediately preced-
ing paragraph. 

CUSTOMER SUPPORT PROVISIONS: Included in the total fee that You have paid for the Software 
and the Documentation is an amount that covers limited customer support services as described in this 
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Agreement (the “Customer Support Services”). ICLUBcentral will provide limited Customer Support 
Services for the length of time described below in the section headed ‘Support Termination/Duration’ 
during the term of this Agreement.   

CUSTOMER SUPPORT OBLIGATIONS OF ICLUBCENTRAL: Provide customer support for the 
Software only if (i) You have performed the online Product Registration as provided by ICLUBcentral in 
order to register the Software; and (ii) Your copy of the Software is identified with a valid serial number, 
and Registration Code. 

Investigate and identify any problem reported by You to ICLUBcentral that is related to the then current 
release of the Software, and correct or provide within an appropriate time, as determined by ICLUBcen-
tral, either (i) a workaround for any programming error in the then current release of the Software which 
You have identified, provided that the error is directly attributable to ICLUBcentral, or (ii) a resolution to 
the problem which You have identified (collectively the “Code Correction Services”). 

RELATED OBLIGATIONS OF END-USER:  

• Use only the then current release of the Software during the term of this Agreement. 
• In the event of (i) a problem with the Software that results in either a system crash or loop; or 

(ii) a situation where You can reasonably demonstrate that the Software produces an errone-
ous arithmetic result that is not a function of incorrect or improper input data, then You must 
submit to ICLUBcentral a written report of all input and keystrokes to the Software giving 
rise to the problem. 

SUPPORT TERMINATION/DURATION: Answers to questions about installation of the Club Tax 
Printer are included with your purchase of the software. Questions about club accounting principles, tax 
issues, and the Club Accounting software are covered by your Club Accounting Maintenance Agreement. 
To receive full Customer Support coverage, you must purchase a Club Accounting Maintenance Agree-
ment and renew it annually.   

LIMITED WARRANTY: ICLUBcentral does not have control over the conditions under which You 
use the Software and does not and cannot warrant the performance or results that may be obtained by its 
use. However, ICLUBcentral warrants that the Software will perform substantially in accordance with 
the Documentation for a period of ninety (90) days from the date the product was shipped to You, pro-
vided that the Software is used on the computer equipment, operating system and in the environment for 
which it was designed and configured. Your sole remedy and ICLUBcentral ‘s exclusive liability under 
the foregoing limited warranty will be the furnishing by ICLUBcentral, within a reasonable period of 
time and without charge, of the Customer Support Services pursuant to the Customer Support Services 
provisions of this Agreement. To bring a claim under this limited warranty, You should contact Support 
Department at ICLUBcentral, 1430 Massachusetts Ave, 3rd Floor, Cambridge, MA 02138 to obtain 
information on warranty performance; You must be given a Return Authorization Number by ICLUB-
central before returning the Software to ICLUBcentral. Some jurisdictions do not allow the exclusion or 
limitation of relief, incidental or consequential damages, so the above limitation or exclusion may not 
apply to You. 

Because computer programs are inherently complex, You are advised to always verify Your work and 
periodically (after each use) back up the data You have created with the Software. 

ICLUBcentral does not warrant that any of the Software, the Documentation or Customer Support Ser-
vices to be provided pursuant to this Agreement will meet Your requirements. The only warranty made 
with respect to the Software is the limited warranty set forth in this Agreement. 

EXCEPT AS SO SPECIFICALLY PROVIDED ABOVE IN THE IMMEDIATELY PRECEDING PA-
RAGRAPH, THERE ARE NO WARRANTIES, REPRESENTATIONS, OR CONDITIONS MADE BY 
ICLUBCENTRAL OR ANY OTHER PERSON INVOLVED IN THE CREATION, PRODUCTION OR 
DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT 
SERVICES, EITHER EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE, THE DO-
CUMENTATION, ANY RELEASES THERETO, OR THE CUSTOMER SUPPORT SERVICES IN-
CLUDING THEIR RESPECTIVE QUALITY, PERFORMANCE, MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. Notwithstanding the above, where 
applicable, if You qualify as a “consumer” under the Magnuson-Moss Warranty Act, then You may be 
entitled to any implied warranties allowed by law for the period of the express warranty as set forth 
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above. Some states do not allow limitations on how long an implied warranty lasts, so the above limita-
tion may not apply to You. This warranty gives You specific legal rights, and You may also have other 
rights which vary from state to state. 

LIMITATIONS OF LIABILITY; INDEMNIFICATION: NEITHER ICLUBCENTRAL NOR ANY 
OTHER PERSON INVOLVED IN THE CREATION, PRODUCTION, DISTRIBUTION OR SUP-
PORT OF THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVIC-
ES WILL BE LIABLE TO YOU OR ANY THIRD PARTY ARISING OUT OF THIS AGREEMENT 
AND/OR YOUR USE OF OR INABILITY TO USE THE SOFTWARE, THE DOCUMENTATION OR 
THE CUSTOMER SUPPORT SERVICES, REGARDLESS OF THE FORM OF THE CLAIM OR 
ACTION, THAT EXCEEDS THE PORTION OF THE FEE YOU HAVE PAID FOR THE SOFT-
WARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES, AS THE CASE 
MAY BE. 

NEITHER ICLUBCENTRAL NOR ANY OTHER PERSON INVOLVED IN THE CREATION, PRO-
DUCTION, OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE CUS-
TOMER SUPPORT SERVICES WILL BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY 
SPECIAL, INCIDENTAL, CONSEQUENTIAL, EXEMPLARY DAMAGES OR OTHER INDIRECT 
DAMAGES OR LOSS OF PROFITS, LOSS OF DATA OR LOSS OF USE DAMAGES ARISING 
OUT OF THIS AGREEMENT; AND/OR 

THE MANUFACTURE, SALE, SUPPLYING OR FAILURE OR DELAY IN SUPPLYING OF THE 
SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES RELATED 
THERETO, EVEN IF ICLUBCENTRAL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 

Some jurisdictions do not allow the exclusion or limitation of special, incidental, consequential, indirect 
or exemplary damages, or the limitation of liability to specified amounts, so the above limitations or 
exclusions may not apply to You. 

YOU AGREE TO INDEMNIFY AND HOLD ICLUBCENTRAL AND ALL OF THE PERSONS IN-
VOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE, THE 
DOCUMENTATION AND THE CUSTOMER SUPPORT SERVICES HARMLESS FROM CLAIMS 
AND DAMAGES OF ANY TYPE WHATSOEVER ARISING FROM ANY THIRD PARTY AS A 
RESULT OF YOUR USE OF THE OUTPUT FROM, AND/OR YOUR INABILITY TO USE THE 
SOFTWARE OR AS A RESULT OF ANY CUSTOMER SUPPORT SERVICES PROVIDED OR TO 
BE PROVIDED UNDER THIS AGREEMENT. 

GEOGRAPHIC LIMITATION: ICLUBcentral Customer Support Services cannot be provided at the 
same level to customers outside of the continental United States, Hawaii and Alaska. ICLUBcentral’s 
website is available to customers anywhere in the world. Email support will be provided, on a best efforts 
basis, to foreign customers, but only in English. It is understood that the ICLUBcentral products have 
been developed for the U.S. marketplace. 

U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and Documentation are “commercial 
computer software” or “commercial computer software documentation.” Absent a written agreement to 
the contrary, the U.S. Government’s rights with respect to such Software or Documentation are limited 
by the terms of this Agreement, pursuant to FAR ‘ 12.212(a) and/or DFARS ‘ 227.7202-1(a), as applica-
ble. 

GENERAL PROVISIONS: The Software, the Documentation, and all releases thereto are licensed to 
You by ICLUBcentral, and are protected by United States copyright laws and by international treaty 
provisions. Title to the Software and the Documentation, and patents, copyrights and all other property 
rights applicable thereto, shall at all times remain solely and exclusively with ICLUBcentral and its li-
censors, and You shall not take any action inconsistent with such title. Therefore, except for the permit-
ted right to make one (1) back up copy of the Software, You must treat the Software and the Documenta-
tion like any other copyrightable material and are precluded by law from making any copies of them. 
Any rights not expressly granted herein are reserved to ICLUBcentral and its licensors. 

The rights and obligations under this Agreement will be governed by, and any arbitration or court action 
hereunder shall apply, the laws of the Commonwealth of Massachusetts, excluding its conflicts of law 
rules, and will not be governed by the United Nations Convention of Contracts for the International Sale 
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of Goods, the 1974 Convention on the Limitation Period in the International Sale of Goods (the “1974 
Convention”) and the Protocol amending the 1974 Convention, done at Vienna April 11, 1980, the appli-
cation of which is expressly excluded.  

Any dispute, controversy or claim arising out of or relating to this Agreement or to a breach hereof, in-
cluding its interpretation, performance or termination, shall be resolved in the courts of Massachusetts.  

The parties irrevocably submit to the exclusive jurisdiction of the federal and state courts of Massachu-
setts. Notwithstanding anything contained in this paragraph to the contrary, ICLUBcentral shall have the 
right to institute judicial proceedings against You or anyone acting by, through or under You, in order to 
enforce ICLUBcentral’s rights hereunder through reformation of contract, specific performance, injunc-
tion or similar equitable relief. 

If any term or condition in this Agreement is invalid or unenforceable in any respect under any applicable 
statute or rule of law, then such term or condition is modified to have the most nearly similar permissible 
economic or other effect in order to be valid and enforceable under such applicable statute or rule of law. 

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND 
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT 
THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE RELATION-
SHIP BETWEEN YOU AND ICLUBCENTRAL, AND SUPERSEDES ALL PRIOR OR CONTEM-
PORANEOUS PROPOSALS, ORAL OR WRITTEN, UNDERSTANDINGS, REPRESENTATIONS, 
CONDITIONS, WARRANTIES, AND ALL OTHER COMMUNICATIONS BETWEEN YOU AND 
ICLUBCENTRAL OR BETWEEN YOU ANY OTHER PERSON INVOLVED IN THE CREATION, 
PRODUCTION OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE 
CUSTOMER SUPPORT SERVICES; AND THIS AGREEMENT MAY NOT BE EXPLAINED OR 
SUPPLEMENTED BY CUSTOM OR USAGE OF TRADE OR ANY PRIOR COURSE OF DEAL-
INGS BETWEEN YOU AND ANY OTHER PERSON. 

IF THERE ARE ANY CONCERNS REGARDING THIS AGREEMENT, PLEASE CONTACT: IC-
LUBCENTRAL, 1430 MASSACHUSETTS AVE, 3rd FLOOR, CAMBRIDGE, MA 02138. 




